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Documentation Updates
The title page of this document contains the following identifying information:
l

Software Version number, which indicates the software version.

l

Document Release Date, which changes each time the document is updated.

l

Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:
http://h20230.www2.hp.com/selfsolve/manuals
This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:
http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport login page.
You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support
that HP Software offers.
HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:
l

Search for knowledge documents of interest

l

Submit and track support cases and enhancement requests

l

Download software patches

l

Manage support contracts

l

Look up HP support contacts

l

Review information about available services

l

Enter into discussions with other software customers

l

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html
To find more information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp
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Chapter 1
Introduction
This guide provides an overview of HP Service Health Reporter (SHR) content development and
describes the process of creating a content pack. You will use sample files available in your SHR
installation media and the instructions in this guide to create a sample content pack.
Note: HP does not provide support for Content Packs created or modified with the Content
Development Environment (CDE) tool, or otherwise, via HP’s standard product
support/service agreements. Any defects found in the underlying CDE tool, however, will be
addressed by HP.

About this Guide
This guide contains the following:
1. See "Introduction" (this chapter): Provides the prerequisites and references helpful in
understanding content packs and content development terminologies used in this guide.
2. See "Content Pack Architecture and Development" on page 10: Describes the architecture of
content packs and introduces the Content Development Environment (CDE). The CDE is a set
of tools provided by SHR that enable you to develop a content pack.
3. See "Creating a Content Pack—Getting Started" on page 14: Provides step-by-step
instructions to create a content pack by using an example of Retail Point of Sales. You will use
the sample files and templates available in the SHR media to create a working content pack.
4. See "Creating an ETL Component Package" on page 42: Provides instructions and sample
files to create a generic ETL content pack component, with limited capabilities, for the Retail
Point of Sales example.
5. See Glossary of terms.

Who Should Read this Guide
This guide is meant for developers who want to create content packs on SHR or extend existing
content packs.

Prerequisites and Reference Documentation
This guide assumes you have a prior understanding of the following:
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Prerequisite

Reference Documentation

HP Service Health Reporter concepts
and usage

Read the following documents available at Start > Programs -> HP Software -> SH Reporter > Documentation
l

Concepts Guide: This guide explains the key
concepts, architecture, and typical workflow of
SHR. Read this guide to understand the concept
and working of content packs before you start
developing any.

l

Installation and Configuration Guide: In this
guide you find instructions to install content
packs and steps to troubleshoot problems during
installation of content packs.

l

Online Help for Administrators: In this Help
you find information about monitoring the
installed content packs.

l

Online Help for Users: In this Help you find
information about the out-of-the-box content
packs provided by SHR.

Data Warehouse concepts

You can find resources related to data warehouse
concepts and examples on the internet. SHR does
not recommend any particular resource.

SAP BusinessObjects reporting concepts

l

SAP BusinessObjects Enterprise InfoView
User’s Guide:This guide is available at Start > Programs -> BusinessObjects >
BusinessObjects Enterprise ->
Documentation. This guide provides
instructions to create and work with Web
Intelligence reports.

l

SAP BusinessObjects Universe Designer
Online Help: In this Help you find information
about creating, building, and managing
Universes. You can launch the Help from the
Universe Designer user interface.

For additional information and the latest help
documents, see
http://help.sap.com/businessobject/product_
guides/.
XML concepts and how to create XML
documents

Page 9 of 59

You can find resources related to XML concepts and
examples on the internet. SHR does not recommend
any particular resource.
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Chapter 2
Content Pack Architecture and Development
SHR enables you to create the following content on the performance management database
platform:
l

Content pack: You can create new content packs and extend the out-of-the-box content packs
provided by SHR. This guide uses an example to describe the steps to create a content pack.

l

Web Intelligence reports: Using the SAP BusinessObjects InfoView application interface you
can create new reports and customize the out-of-the-box reports provided by SHR.

Content Pack Architecture
A content pack is a domain or application specific data mart deployed on the SHR performance
management database platform. Content packs determine the metrics to be collected, how to
process and store the metrics, and display the processed data on the reports.

Components of a Content Pack
A typical content pack consists of three components - the Domain, Extraction Transformation
Loading (ETL), and Reports components.
The following figure shows the typical data flow between the components.
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Domain Component
The Domain component defines the data model of the domain you are reporting on along with the
logic to perform processing on the data. It requires domain experts to model the data according to
the business requirements. This component is independent of the data source. The Domain
component includes:
l

The data model consisting of the facts and dimensions of the domain you are reporting on and
the relationship between them.

l

Workflow streams that control and monitor the processing of the data. A stream is made up of
steps that are related to one another in a sequential relationship. A content pack contains a set
of workflow streams that define and control the flow of data from one step to another. In the
Domain component of a content pack, workflow streams are defined in XML files to load the
data into tables and perform offline aggregation of the data.

l

Optionally defines the dimensions and cubes for the business view to be used by one or more
Reports components.
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Extraction Transformation Loading (ETL) Component
The ETL component is data source dependant; it defines the collection of data from the specified
data source, followed by transformation and loading of the data into the data warehouse. Therefore,
for a particular domain, each data source application has a separate ETL content pack component.
Before you start creating the ETL component you must identify the data source that provides the
metrics suitable to be fed into the domain data model. The ETL component includes the following:
l

Data Collection (Extraction) rules: After you identify a data source you must create a collector
program or use an existing collector program to collect the required facts and dimensions from
the data source. A collection policy must be written in XML to define the metrics to be collected
by the collector program from the data source. The collector program collects data as defined in
the collection policy and places this data into .csv files.
SHR supports data collection from a set of known data sources and provides collector programs
for each such data source.
The data sources supported by SHR are:
n

Run-time Service Model (RTSM)

n

HP Operations agent

n

HP Operations Manager

n

HP Business Service Management Profile Database

n

Generic .csv files

n

Databases supporting JDBC.

l

Data Transformation rules (optional): Data transformation rules are required if the collected
data, as .csv files, need to be transformed before loading the data into the data warehouse. For
example, you can write a rule to remove the rows that contain an empty value in the ‘host name’
column. Transformation rules are written in XML files. SHR provides a data transformation utility
called the ‘mapper’ utility for the out-of-the-box transformation rules.

l

Data Reconciliation rules (optional): Data reconciliation is the process of associating fact
data to the corresponding dimension data. In SHR data reconciliation rules are written to
associate fact data from one source to the corresponding dimension data from another source
using common business keys. For example, in the Service and Operations Bridge (SaOB)
deployment, the dimension data is collected from RTSM and the fact data is collected from HP
Operations agent. Reconciliation rules are written in XML to reconcile the fact data with the
dimension data.

l

Data Staging rules: After the data (in the form of .csv files) is collected, transformed, and
reconciled, it is moved to staging tables. Data staging rules define how the data must be moved
to staging tables including the process to merge columns and rows.
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l

Workflow Stream definitions: In the ETL component, workflow streams are defined in XML to
control the data movement from collection to stage through transformation and reconciliation
steps if required.

Reports Component
The Reports component contains the SAP BusinessObjects Web Intelligence reports and
universes. A content pack universe provides a business-oriented meaningful mapping of the
underlying complex database and simplifies the creation of reports. It is a logical view of the
underlying data model that you define in the Domain component. The Reports component imports
the dimensions and cubes defined in the corresponding Domain component.

Introducing the Content Development Environment
The Content Development Environment (CDE) consists of a set of tools that you use during the
process of content development. These tools use XML files authored by the content pack developer
to generate the installable content pack component packages.
The CDE tools are provided in the SHR media as a self-extracting CDE.exe file in the <installation_
directory>. Upon extraction of the file contents CDE provides a folder structure as shown in the
following figure.
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Creating a Content Pack—Getting Started
This chapter describes the steps to create a sample content pack by using a real world example
related to the retail sales industry. The following flowchart shows the typical steps as well as
simplified steps to create a content pack. To evaluate if you want to use the simplified steps, see
section ""When to use CDE Simplified?" on the next page".

Preparing for Content Development
Study the Business Domain
Consider a large electronics retail chain with:
l

100 stores spread across five locations

l

Each store having about 10,000 individual products on its shelves, the individual products
identified by Stock Keeping Units (SKUs).

The retail chain is automated and each product has a scanner label attached to it. The collection of
transaction data is done mainly at the Point-of-Sale (PoS) system at the front door of the store
where the bar codes are scanned and directly entered into the system. The customer takeaway is
measured at this place.
After you understand the retail store chain business you can proceed to determine the business
user personas and their respective reporting requirements.

Identify User Personas and Reporting Requirements
In the Retail Point of Sales example, we consider the business management personnel as the
users of the reports.
The management users are interested in a sales summary report that shows the product sales
information for different product categories in stores located across different locations. The sales
information must be available across time periods such as yearly, quarterly, monthly and daily.
It is recommended to create a design mock-up of the required reports at this stage. This initial
mock-up can be created on paper or any design tool of choice. The actual development of the Web
Intelligence reports by using SAP BusinessObjects can be done when you create the Reports
component package.

HP Service Health Reporter (9.31)
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Extract and Configure CDE
1. Logon to the host system where SHR is installed. In the <installation_directory> you find an
application named CDE.exe.
2. Run the file CDE.exe to extract the CDE tools into the CDE folder.
3. Type cmd and press ENTER to open the Command Prompt window.
4. At the command prompt run the cd command to navigate to the directory where SHR is
installed. Then run the following commands to change the directory:
a. <installation_directory>cd CDE which sets the directory at <installation_directory>\CDE.
b. <installation_directory>\CDE> cd bin which sets the directory at <installation_
directory>\CDE\bin.
Here <installation_directory> is the directory where SHR is installed.
5. Run the following command:
setenv.bat

The following environment variables are set in the path
CDE_HOME
ANT_HOME
JRE_HOME

When to use CDE Simplified?
The simplified method of creating a content pack can be used in the following cases:
1. When a fact table is associated with one or more dimensions (star schema) and the
dimensions are not further normalized (dimensions without a parent table).
2. When all the facts are to be reconciled against host (when HP Performance Agent is the data
source).
3. When the generated reports do not require any roll up or drill down of data.
If you wish to follow the CDE simplified steps, see section ""Creating a Content Pack—Simplified"
on page 49". Otherwise, use the regular method for content development using section ""Creating a
Content Pack—Getting Started" on the previous page".
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Creating and Installing the Domain Component
The following flowchart shows the typical steps to create the Domain component of a content pack.

Create the Directory Structure
To create the directory structure for the Domain component source files, at the command prompt
run the following command:
<installation_directory>\CDE\bin>CreateCPFolders.bat -package RetailPOS subpackage RetailPOSDomain -type domain
where,
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l

<installation_directory> is the directory where you have installed SHR

l

RetailPOS is the name of the content pack you are developing

l

RetailPOSDomain is the name of the Domain component within RetailPOS

The directory will contain templates provided by SHR that you will use to create the Domain
component source files — the model XML and the workflow streams XML files.
SHR provides sample source files for the Retail POS content pack at the following location. You
can use these files as reference to create your own content pack.
%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\

Identify the Grain, Dimensions, and Facts
The grain of the fact table is the most granular data. In the Retail Point of Sales Domain example,
the grain is an individual line item on a Point of Sales transaction.
The dimensions are:
l

Date

l

Product

l

Store

The facts collected by the Retail Point of Sales system are:
l

Quantity of Sales

l

Amount of Sales

Design the Data Model
A data model illustrates the relationship between entities (facts and dimensions tables) and their
attributes (database table columns). In SHR, a data model is an XML file. To create a data model
start by creating a schema diagram and then implement the same into an XML file.
The following figure shows the schema diagram that we will use to create the data model for the
RetailPOS Content Pack.
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Implement the Data Model in XML
The schema that you designed in the previous step must be implemented using XML to be used by
the CDE to create the Domain component package. This XML file is called Model XML.
A typical Model XML file has the following sections:
l

Relational section defines the fact tables and dimension tables, and the relationship between
the facts and dimensions.

l

Logical section defines the cubes, hierarchies, and levels. You define one cube for every fact
table.

l

Aggregate section defines the aggregation to be performed on the source tables.

After you create the Domain component directory structure you find a template model_
template.xml at the following path:
%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\source\model
You can edit this .xml file to author the Model XML.
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Also, for reference you can find a sample Model XML file for the RetailPOSDomain available at the
following location:
%CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\Source\RetailPOS\RetailPOSDomain.ap\source\model
To read the contents of the sample Model XML file, on this PDF document click the Attachments:
View File Attachments tab and select RetailPOS_dimension_model.xml. Double click to open
the XML file on your browser window.

Create the Workflow Streams
SHR provides a workflow framework to control and monitor the workflow of the data processes.
This framework is made up of workflow streams. A stream is made up of steps that are related to
one another in a sequential relationship. Each content pack contains a set of streams that define
and control the flow of data from one step to another.
As an example, the Domain component may have the following steps in the workflow stream:
Loading data to rate table -> Hourly aggregation -> Daily aggregation
You must implement the workflow streams in XML to be used by CDE to create the Domain
component package. The streams that you must create using XML are:
l

One workflow stream XML to load and aggregate the fact.

l

One workflow stream XML to load the Store dimension.

l

One workflow stream XML to load the Product dimension.

After you create the directory structure for the Domain component you find a workflow stream
template file named ABC_stream_template.xml at the following path:
%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\source\orchestration
You can edit this ABC_stream_template.xml file to author the workflow streams XML files.
Also, as reference you can find sample workflow streams XML files for the RetailPOSDomain at
the following location:
%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\
To read the contents of the sample workflow stream XML files, on this PDF document click the
Attachments: View File Attachments icon and select the following .xml files:
l

Implement the Data Model in XML: Workflow stream XML to load and aggregate the fact.

l

Dimension_Store_stream.xml: Workflow stream XML to load the Store dimension.

l

Dimension_Product_stream.xml: Workflow stream XML to load the Product dimension.

Double click to open the XML files on your browser window.
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Use CDE to Generate Domain Component Package
To generate the Domain component package, follow these steps:
1. Create Manifest XML file
The Manifest XML file contains the definitions of the source files to be used by CDE to
generate the Domain component package.
To create the Manifest XML file using CDE:
a. Using the cd command change directory to:
%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap
b. Run the following command:
antcreateManifestTemplate
The Manifest XML file named RetailPOSDomain_manifest_template.xml is created in
%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\source
You can see a sample Manifest XML file for the RetailPOSDomain at the following location:
%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\RetailPOS\RetailPOSDom
ain.ap\source\RetailPOSDomain_manifest_template.xml

To read the contents of the sample Manifest XML file, on this PDF document click the
Attachments: View File Attachments icon and select RetailPOSDomain_manifest_
template.xml.Double click to open the XML file on your browser window
2. Build Domain component package
To create the Domain component package using CDE:
a. Using cd command change directory to:
%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap
b. Run the following command:
ant

The installable Domain component package is created in
%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\dist
3. Browse to %CDE_HOME%\workspace\RetailPOS\RetailPOSDomainCP.ap\dist
4. Copy RetailPOSto %PMDB_HOME%\packages.Copying the package makes it available in the
Deployment Manager for installation.
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Note: It is not necessary to have SHR installed on the machine where you are creating the
Domain component package. If you created the Domain component package on another
machine, you must copy the package to the SHR machine under %PMDB_
HOME%\packages.

Install the Domain Component Package
SHR provides the Deployment Manager utility on the Administration Console to install the content
pack component packages. For instructions on how to install the content pack components, see
the HP Service Health Reporter Installation and Configuration Guide.

Creating and Installing the ETL Component
The ETL component consists of data collection, transformation, reconciliation, and staging rules.
The creation of the complete ETL component using all the rules can be quite complex. Therefore, to
enable you to create a sample content pack this chapter describes a simple alternative method to
generate data in the form of .csv files and load into the data warehouse.
The following chapter See "Creating an ETL Component Package" on page 42 describes the
creation of an ETL component package that you can install by using the Deployment Manager on
the Administration Console.

Custom Data Loading Using CSV Files
In this method you create a set of CSV files in the required format and place them in the following
locations which are then loaded into the SHR data warehouse tables:
%PMDB_HOME%\stage (Windows)
$PMDB_HOME/stage (Linux)
Perform these steps to create and load the .csv files.
1. Install the Domain component package: Before you begin creating the CSV files for
loading, make sure you generate the Domain component package you created in "Install the
Domain Component Package" above. The Domain component creates a stage
interfacehtml file that contains the format in which the CSV files must be created. The stage
interface html file is created in the following directory:
%PMDB_HOME%\packages\RetailPOS\RetailPOSDomainCP.ap\doc (Windows)
$PMDB_HOME/packages/RetailPOS/RetailPOSDomainCP.ap/doc (Linux)
For reference, see the example RetailPOSDomain_INTERFACE.html file available in %CDE_
HOME%\samples\RetailPOS_Demo_Content_Pack\RetailPOS\RetailPOSDomain.ap\doc
(Windows) or $CDE_HOME/samples/RetailPOS_Demo_Content_
Pack/RetailPOS/RetailPOSDomain.ap/doc (Linux).
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2. Generate CSV files: SHR provides a simple CSV files generator program to create sample
.csv files for the RetailPOS content pack. To create the CSV files in the given format provided
in the template .html file by using the.csv file generation program follow these steps:
a. Browse to the folder:
o

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Sample CSV Generator.
(Windows)

o

$CDE_HOME/samples/RetailPOS_Demo_Content_Pack/Sample CSV Generator.
(Linux)

b. Copy the following files to the specified location as shown in the following table:
File

Copy to location

retailpos_csvgen.exe

%PMDB_HOME%\bin (Windows)
$PMDB_HOME\bin (Linux)

retailpos_csvgen.ini

%PMDB_HOME%\config\startup (Windows)
$PMDB_HOME\config\startup (Linux)

retailposcsvgen.jar

%PMDB_HOME%\lib (Windows)
$PMDB_HOME\lib (Linux)

c. For Windows, run retailpos_csvgen.exe. in the command prompt. For Linux, go to the
$PMDB_HOME\bin directory and run ln -s launcher retailpos_csvgen in the shell
prompt.
For the sample RetailPOS content pack that you are creating, the .csv file generator program
generates two months worth of .csv files and places these files in the %PMDB_HOME%\stage
folder (Windows) or the $PMDB_HOME/stage directory (Linux). The Domain component that you
installed earlier loads the CSV files to the SHR data warehouse tables.

Verifying Workflow Streams on Administration
Console
After the HP_PMDB_Platform_Timer service is started, you logon to the Administration Console to
check the status of the Domain component workflow streams. Follow these steps:
1. On the Administration user interface, click Internal Monitoring-> Data Processing.
2. On the Stream Details tab, view the status of streams in the RetailPOSDomain content pack.
All streams must show a status of OK to indicate successful completion.
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In the RetailPOS example, the Domain component has the following workflow streams with one or
more steps within each stream.
l

A workflow stream XML to load and aggregate the Retail_Sales fact.

l

A workflow stream XML to load the Store dimension.

l

A workflow stream XML to load the Product dimension.

l

A workflow stream XML to load the Promotion dimension.

As shown in the following figure, successful completion of the streams is indicated using green
color.

Creating and Installing the Reports Component
The following flowchart shows the steps to create the Reports component.
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Prerequisites
Before you create the Reports component, make sure the following are done:
l

CDE is installed on the same machine where you have installed SHR and SAP
BusinessObjects.

l

The Domain component that you created in See"Install the Domain Component Package" on
page 21 is installed. Use the Deployment Manager utility on the Administration Console to install
the Domain component. For instructions, see the HP Service Health Reporter Installation and
Configuration Guide.

Create the Directory Structure
To create the directory structure for the Reports component source files, at the command prompt
run the following command:
<installation_directory>\CDE\bin> CreateCPFolders.bat -package RetailPOS -subpackage
RetailPOSApp -type application
where,
l

<installation_directory> is the directory where you have installed SHR

l

RetailPOS is the name of the content pack you are developing

l

RetailPOSReporting is the name of the Reports component within RetailPOS

The directory will contain templates provided by SHR that you will use to create the Reports
component source files.
SHR provides sample source files for the Retail POS content pack at the following location. You
can use these files as reference to create your own content pack.
%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\

Write the Model XML Document
The Model XML document for the Reports component must have a Logical section. In this section,
you provide a reference to the cube that you defined in the Domain component Model XML
document.
For reference find a sample Model XML file for the RetailPOSReporting available at the following
location:
%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\RetailPOS\RetailPOSReporti
ng.ap\source\model
To read the contents of the sample Model XML file, on this PDF document click the Attachments:
View File Attachments tab and select RetailPOS_App_model.xmlDouble click to open the XML
file on your browser window.
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Create the Manifest XML File
The Manifest XML file contains the definition of the Model XML document that you created in See
"Write the Model XML Document" on the previous page to be used by CDE.
To create the Manifest XML file using CDE:
1. Using the cd command change directory to:
%CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap
2. Run the following command:
antcreateManifestTemplate
The Manifest XML file named RetailPOS_manifest_template.xml is created in %CDE_
HOME%\workspace\RetailPOS\RetailPOSReporting.ap\source
You can see a sample Manifest XML file for the RetailPOSReporting at the following location:
%CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\Source\RetailPOS\RetailPOSReporting.ap\source

Create a Connection to SAP BusinessObjects
To generate the SAP BusinessObjects Universe you must create a secured database connection
to SAP BusinessObjects by using the Universe Designer. SHR provides a batch script to create
the connection. To create a connection by using the script:
1. Using the cd command change directory to:
%CDE_HOME%\bin
2. At the command prompt, run the following:
setenv.bat

3. At the command prompt, run the following batch script:
createUniverseConnection.bat

A message ‘Default BO Universe connection (“MA”) was created successfully’
appears.

Use CDE to Generate SAP BusinessObjects Universe
To generate the universe by using CDE, at the command prompt:

HP Service Health Reporter (9.31)

Page 26 of 59

Content Development - Getting Started Guide
Chapter 3: Creating a Content Pack—Getting Started

1. Using the cd command change directory to
%CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap
2. Run the following command:
ant

The universe is created with a filename extension of.unv and placed under the following folder:
%CDE_
HOME%
\workspace\RetailPoS\RetailPoSReporting.ap\dist\RetailPOS\RetailPOSReporting.ap
Tip: You can also edit the Universe to add additional hierarchies. See the SAP
BusinessObjects Universe Designer Online Help for more information.

Export the Universe to SAP BusinessObjects Repository
On the SAP BusinessObjects Universe Designer:
1. Select File-> Export. The Export Universe window opens.
2. Select the required universe folder, in this example the RetailPOS, from the available list. Click
OK.
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3. On the Export Universe window, browse to the location of universe, in this example, the
RetailPOSReporting.unv. Click Open.

The Export Universe window shows the RetailPOSReporting.unv added to the list of
universes to be exported. Click OK.
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4. The universe successfully exported message appears.

Create Web Intelligence Reports
You can create Web Intelligence reports by selecting the universe in SAP BusinessObjects
InfoView and building one or more queries to define the data content of the reports.
To create a simple sales report containing a table of sales quantity and sales amount per product
category, follow these steps:
1. Logon to SAP BusinessObjects InfoView by using one of the following ways:
n

In the address bar of your web browser, type the URL of the SAP BusinessObjects system.
The URL of the machine will be in the format: http://<Host Name or IP address>:PORT
NO (8080)/InfoViewApp/logon.jsp.

n

In the Administration Console, click Administration->SAP BOBJ and then click Launch
InfoView. The InfoView login page opens.

2. Click Document List.
3. Click New -> Web Intelligence Document. The list of BusinessObjects Universes appears.
4. Select RetailPOSReporting Universe - Model Generator.The New Web Intelligence
Document window opens. The data tab shows the objects – dimensions and measures –
available in the universe as shown in the following figure.
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5. To include data in the report, select the following in the data tab and drag them into the Result
Objects window. Alternatively, you can double click the objects to place them in the Result
Objects window.
n

Dimension: Category (under Product(Retail Sales))

n

Measures:
o

Sale Quantity (under Sales Measures)

o

Sale Amount (under Sales Measures)

6. Click Run Query to return the data to the report.
A table of Sale Quantity and Sale Amount by Product Category is created. You can rename the
table to an appropriate title.
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Enabling Time Drill Option in Reports
To enable time drill option in the report, click Drill
down and roll up by the product category dimension.

on the InfoView toolbar. You can drill

Note: Option 1: If you developed the Web Intelligence reports on a different system where
SHR is not installed, you must do the following:
l

Export the BIAR file to the system where SHR is installed

l

Generate the Reports component and install it using the Deployment Manager.

See instructions for See "Exporting Reports to SHR" below
Option 2: If you developed the Web Intelligence reports on the same system where SHR is
installed, you can verify the workflow streams and view the reports on the SAP
BusinessObjects InfoView as described in the following sections.

Exporting Reports to SHR
Export Business Intelligence Archive Resource (BIAR)
File
If you developed the reports on a system where SHR is not installed, you must export the BIAR file
and install the Reports component on the system where SHR is installed. You select a source, a
destination, and the objects that you want to import. Follow these steps:
1. Open the BusinessObjects Import Wizard.
2. On the Source environment page, enter the following:
n

CMS Name: The name of the machine on which BusinessObjects is installed

n

User Name: The username for BusinessObjects user.

n

Password: The password for BusinessObjects user.
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n

Authentication: Select Enterprise.

3. On the Destination environment page, select the following:
n

Destination: Business Intelligence Archive Resource (BIAR) File.

n

BIAR file: The .biar file you want to export to. The path of the.biar file is
%CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap\source\reports\sybas
e\
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4. On the Select objects to import page, select the following:
n

Import folders and objects.

n

Import repository objects.

n

Import universes.
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5. On the Import options for universes and connections page, select the following option:
Import the universes and connections that the selected Web Intelligence and
Desktop Intelligence documents use directly.
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6. On the Universe folder and universes page, select the RetailPOS universe. Click Next.
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7. On the Import options for publications page, select the Do not import recipients option

The Ready to import page appears. Click Finish to import the universe.
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Create the Manifest XML File
The Manifest XML file contains the definition of the BIAR file that you exported in the previous step
to be used by CDE.
To create the Manifest XML file using CDE:
l

Using cd command change directory to:
%CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap

l

Run the following command
antcreateManifestTemplate

The Manifest XML file named RetailPOSReporting_manifest_template.xml is created in
%CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap\source
Fore reference, see a sample Manifest XML file for the RetailPOSReporting at the following
location:
%CDE_HOME%\samples\

Use CDE to Generate Reports Component Package
To generate the Reports component package using CDE:
1. Using cd command change directory to:
%CDE_HOME%\workspace\RetailPOS\RetailPOSReporting.ap
2. Run the following command
ant

The Reports component package named RetailPOSReporting.ap is created in
%CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\dist
3. Browse to %CDE_HOME%\workspace\RetailPOS\RetailPOSDomain.ap\dist.
4. Copy RetailPOSReporting.ap to %PMDB_HOME%\packages\RetailPOS

Install the Reports Component Package
SHR provides the Deployment Manager utility on the PMDB Platform Administration User Interface
to install the content pack component packages.
For instructions on how to install the content pack components, see the HP Service Health
Reporter Installation and Configuration Guide.
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After you install the Reports component package, you can verify the workflow streams on the
Administration Console and view the reports on SAP BusinessObjects InfoView.
See "Verifying Workflow Streams on Administration Console" on page 22
See "Viewing Reports on SAP BusinessObjects InfoView" below.

Viewing Reports on SAP BusinessObjects InfoView
Now that you installed the Domain and Reports component packages and the data is loaded into
the data warehouse, you can view the reports on the SAP BusinessObjects InfoView interface.
If you installed the sample RetailPOS_Demo_Content_Pack from %CDE_HOME%\samples\ you
see a report named Retail Sales Report available in the Document List in InfoView. For
instructions on how to logon to InfoView and view reports, see HP Service Health Reporter Online
Help for Users.
The Retail Sales Report contains the Sales Summary document which displays the sales revenue
information for each of the dimensions that you defined in the data model – location, time, and
product category. You can drill down and roll up on the dimensions to view granular information.

Developing Content in Linux using CDE
During SHR installation in Linux, client tools of SAP BusinessObjects are also installed but they
are not supported on Linux. If SHR is installed on a Linux server, you must use a Microsoft
Windows XP or later system for developing or customizing application content.

Prerequisites
A system with the following software:
1. Microsoft Windows XP or later operating system.
2. JavaTM Platform, Standard Edition Development Kit (JDKTM) 1.7.
Download from http://www.oracle.com/.
3. SAP BusinessObjectsXI 3.1 Client.
a. Copy the BusinessObjectsXI-3.1-Clienttools.zip file from the bits/packages/BO folder of
the Linux installation media to the Windows system.
b. Extract the contents of the ZIP file to the Windows system.
Two folders—BusinessObjectsXI-3.1-Clienttools\SP5Client and BusinessObjectsXI-3.1Clienttools\SP5.3Client—are created.
c. Run the setup.exe file from both the folders; start with the SP5Client setup.exe.
d. Follow the instructions on the installer wizard to perform the installation.
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Extract and Configure CDE
1. On the Linux server where SHR is installed, from the /opt/HP/BSM directory, copy the
CDE.zip file.
2. Extract the contents of the ZIP file to the root/CDE directory.
3. Navigate to the root/CDE/bin directory and provide execution rights to shell scripts.
4. Run the setenv.sh command.
The following environment variables are set:
n

CDE_HOME

n

ANT_HOME

n

JRE_HOME

n

JRE_BIN

Creating the Application Component
1. On the Linux server where SHR is installed, navigate to the /opt/HP/BSM directory.
2. Copy the CDE.zip file to the Windows system.
3. Extract the contents of the GZ file to the C:\CDE folder.
4. From the C:\CDE\bin folder, run the setenv.bat command with the complete directory path of
CDE and Java Runtime Environment (JRE) as follows:
setenv.bat -CDE_HOME C:\CDE -JRE_HOME C:\Java\jdk1.7.0_xx\jre
5. From the C:\CDE\bin folder, run the updateCDEProperty.bat file.
a. Enter values for the bo.username and bo.password parameters.
b. Enter the short name of the SHR server for the bo.server= field.
For example, bo.server=shrdev
6. Install the SAP Sybase IQ Network Client 15.4.
a. Copy the SybaseIQ32_odbcDriver.zip file available in the C:\CDE\bin folder.
b. Extract the contents of the ZIP file to the Windows system.
c. Run the setup.exe file in the C:\CDE\bin\SybaseIQ32_odbcDriver folder.
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7. From the Windows Start button, launch Sybase > Sybase IQ 15.4 > ODBC Administrator
32-bit. The ODBC Data Source Administrator dialog box appears.
8. Select the System DSN tab and click Add. The Create New Data Source dialog box
appears.
9. From the options available in the row called Name, scroll to select Sybase IQ and click
Finish. The ODBC Configuration for SQL Anywhere dialog box appears.
10. From the ODBC tab, in the Data source name field, enter BSMR.
11. From the Login tab, perform the following actions:
a. For User ID, enter pmdb_admin.
b. For Password, enter the PMDB schema password.
c. For Action, select Connect to a running database on another computer.
d. For Host, enter the FQDN of the SHR server.
e. For Port, enter 21424.
f. For Server name, enter the short name of the SHR server.
12. From the ODBC tab, click Test Connection; when successful, click OK.
13. From the Windows Start button, launch Business Objects XI 3.1 > Business Objects
Enterprise Client Tools > Designer. The User Identification dialog box appears.
a. For Server, enter the short name of the SHR server.
b. For User Name, enter Administrator.
c. For Password, enter the SAP BusinessObjects Administrator password. By default, no
password is required.
d. For Authentication, select Enterprise.
e. Click OK. The Universe Designer window appears.
14. To create a connection to the SHR database, select Tools from the menu and click
Connections. The Wizard Connection dialog box appears.
a. Click Add. The Define a new connection wizard appears.
b. Click Next.
c. For Connection Type, select Secured.
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d. For Connection Name, enter MA.
e. From the network layer pane, select Sybase > Sybase IQ 15 > ODBC Drivers.
f. Click Next.
g. For Authentication Mode, select Use specified username and password.
h. Leave the User name and Password fields empty.
i. For Data source name, enter BSMR.
j. Click Next > Next > Finish.
k. On the Wizard Connection dialog box, click Finish.
A new BusinessObjects connection by the name MA is created.
15. Launch the Command Prompt and run the following command to create the application
content pack directory structure:
createCPFolders.bat -package cpname -subpackage subpackagename.ap -type
application
16. Navigate to the %CDE_HOME%\workspace \package\subpackagename.ap folder and run the
following commands:
n

ant createManifestTemplate

n

ant

17. The universe is created with a UNV extension and placed in the %CDE_HOME%\workspace
\package\subpackagename.ap\dist folder.
18. Export the universe to the SAP BusinessObjects Server. For more information, see section
"Export the Universe to SAP BusinessObjects Repository".
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Creating an ETL Component Package
This chapter describes the steps to create an ETL component package for the existing RetailPOS
Domain component package.
Creating an ETL Component package involves the following steps:

Note: This Chapter does not describe data reconciliation.

HP Service Health Reporter (9.31)

Page 42 of 59

Content Development - Getting Started Guide
Chapter 4: Creating an ETL Component Package

Prerequisite
Create and Install the Domain Component Package
Follow the steps described in See "Creating and Installing the Domain Component" on page 16 to
create the Domain model and use CDE to generate the Domain component package.

Analyze the Data Source
As described in the chapter See "Content Pack Architecture and Development" on page 10, before
you start creating the ETL component, you must identify the data source containing metrics that are
suitable to be fed into the Domain data model.
In this guide we consider a simple database as the source of data. The database is created using
PostgreSQL software and contains data suitable to be fed into the RetailPOS Domain model.
Sample files and scripts are provided in the SHR media to create the database and populate data
into the tables. The "Creating a Data Source for ETL Component" describes how to create the
PostgreSQL database, the database tables, and how to insert data into the tables.

Create the Directory Structure
To create the directory structure for the ETL component source files, at the command prompt run
the following command:
<installation_directory>\CDE\bin>CreateCPFolders.bat -package RetailPOS -subpack
age RetailPOSETL -type etl
where,
l

<installation_directory> is the directory where you have installed SHR

l

RetailPOS is the name of the content pack you are developing

l

RetailPOSETL is the name of the ETL component within RetailPOS

The directory will contain templates provided by SHR that you will use to create the ETL
component source files.
SHR provides sample source files for the Retail POS content pack at the following location. You
can use these files as reference to create your own content pack.
%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\

Define Collection Policy in XML
To collect the data from the retailpos database tables you must define a collection policy in XML.
Use the collection policy template named DB_collection_template.xmlavailable in the following
folder:
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%CDE_HOME%\workspace\RetailPOS\RetailPOSETL.ap\source\etl\collection\
For reference see the sample RetailPOS_DB_Collection_Policy.xml in the following folder:
%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\RetailPOS\RetailPOSETL.ap\
source\etl\collection\
To read the contents of the sample collection policy XML file, on this PDF document click the
Attachments: View File Attachments icon and select RetailPOS_DB_Collection_Policy.xml.
Double click to open the XML file on your browser window.

Define Data Transformation Rules
In the RetailPOS example, the data transformation rule is used to append the name of the city,
state, country, and the zip code to the address column; and use the whitespace character as a
delimiter of the column values in the .csv files.
For reference see the sample RetailPOS_transformation.xml in %CDE_
HOME%\samples\RetailPOS_Demo_Content_Pack\RetailPOS\RetailPOSETL.ap\doc
To read the contents of the sample data transformation rule XML file, on this PDF document click
the Attachments: View File Attachments icon and select RetailPOS_transformation.xml.
Double click to open the XML file on your browser window.

Define Stage Rules
Stage rules defined in XML files are used to map the column names in the source .csv files to the
column names in the target physical tables, called staging tables, in the database. Use the stage
rules template available in the folder RetailPOS\RetailPOSDomain.ap\source\stagerule_
templates to write the stage rules XML files for each of the dimensions – product, sales, and store.
For reference see the sample stage rule XML files in %CDE_HOME%\samples\RetailPOS_
Demo_Content_Pack\RetailPOS\RetailPOSETL.ap\source\etl\stage_rules
For all the OOTB domain content packs, stage rule templates are available in the folder %CDE_
HOME%\cplib\<ContentPack>\<SubPackage.ap>\source\stagerule_templates
Taking the System Management Content Pack for example, the syntax is C:\HPSHR\CDE\cplib\SystemManagement\CoreSystemManagement.ap\source\stagerule_
templates
To read the contents of the sample stage rule XML files, on this PDF document click the
Attachments: View File Attachments icon and select the following files:
l

Stage_product_stagerule.xml:Stage rule for Product

l

Stage_retail_sales_stagerule.xml: Stage rule for Sales

l

Stage_store_stagerule.xml: Stage rule for Store

Double click to open the XML files on your browser window.
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Define Workflow Streams
Workflow streams defined in XML files are used to collect and stage the .csv files in the data
warehouse.
When topology information is collected, SHRCollector generates a *relations*.csv file for each
topology view in addition to the CI type mentioned as part of the RTSM collection policy. You must
author stage rules to stage this data and workflow streams to enable the process of loading the
*relations*.csv files.
The *relations*.csv files contain topology data thatmust be loaded to the CI Bridge table. To
create a stage rule definition for the CI Bridge, use the stage rule templates for the CI Bridge
available in the folder %CDE_HOME%\cplib\Core\Core.ap\source\stagerule_templates[Core_
0_Stage_K_CI_Bridge_0_stagerule.xml].
In addition to authoring stage rules, you must define a workflow stream to enable the data flow. For
the syntax on creating ABC Streams, see HP Service Health Reporter Content Development Reference Guide.
Note: In the COLLECT step, use the "View name" specified in the collection policy as the
Category and "Relations" as the Type.
Use the workflow streams template available in the folder%CDE_HOME%\samples\RetailPOS_
Demo_Content_Pack\source\RetailPOS\RetailPOSETL.ap\source\orchestration\stream_
definitions to write the workflow stream XML files, one file for each of the dimensions – product,
sales, and store.
For reference see the sample workflow stream XML files in %CDE_
HOME%\samples\RetailPOS_Demo_Content_
Pack\RetailPOS\RetailPOSDomain.ap\source\orchestration\stream_definitions
To read the contents of the sample ETL workflow stream XML files, on this PDF document click the
Attachments: View File Attachments icon and select the following files:
l

Dimension_Product_ETL_stream.xml:Workflow stream XML for Product dimension

l

Dimension_Store_ETL_stream.xml:Workflow stream XML for Store dimension

l

Fact_Retail_Sales_ETL_stream.xml:Workflow stream XML for the fact

Double click to open the XML files on your browser window.

Generate the ETL Component
To generate the ETL Component package using CDE:
1. Using cd command change directory to:
%CDE_HOME%\workspace\RetailPOS\RetailPOSETL.ap

Page 45 of 59

HP Service Health Reporter (9.31)

Content Development - Getting Started Guide
Chapter 4: Creating an ETL Component Package

2. Run the following command:
ant

The ETL component package is created in
%CDE_HOME%\workspace\RetailPOS\RetailPOSETL.ap\dist
3. Browse to %CDE_HOME%\workspace\RetailPOS\RetailPOSETL.ap\dist
4. Copy RetailPOS to %PMDB_HOME%\packages.Copying the package makes it available in the
Administration Console Deployment Manager for installation.

Install the ETL component
SHR provides the Deployment Manager feature on the Administration Console to install the content
pack component packages. Use the Deployment Manager to install the ETL component package;
in the RetailPOS example, the name of the package is RetailPOSETL.
For instructions on how to install the content pack components by using Deployment Manager, see
the HP Service Health Reporter Installation and Configuration Guide.

Working with the ETL Component
Configure a Generic Database
After you install the RetailPOS Domain and ETL components, you must configure a connection to
the retailpos database to collect data based on the collection policy XML. You configure the
connection on the Administration Console using the Generic Database page. Follow these steps:
1. In the Administrator Console, click Collection Configuration ->Generic Database. The
Generic Database page opens.
2. Click Create New. The Connection parameters dialog box opens.
3. Type or select the following values:
Field

Description

Host name

Type the IP address or FQDN of the server where you created the
retailpos database.

Port

Type the port number to query the database server.

TimeZone

Select the time zone under which the database instance is
configured.

Database type

Select POSGRESQL.
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Field

Description

Domain

Select RetailPOS.

URL

Type jdbc:postgresql//<server>:<port>/retailpos

User Name

Type the name of the generic database user. In this example, the
user name is retail_admin.

Password

Type the password of the generic database user. In this example,
the password is retail admin.

Verify the ETL Component
After you install the ETL component package and the HP_PMDB_Platform_Timer service is started,
you logon to the Administration user interface to check the status of the ETL component workflow
streams. Follow these steps:
1. On the Administration user interface, click Internal Monitoring -> Data Processing.
2. On the Stream Details tab, view the status of streams in the RetailPOSETL content pack. All
streams must show a status of OK to indicate successful completion.
In the RetailPOS example, the ETL component has the following workflow streams with one or
more steps within each stream.
l

A workflow stream RetailPOSETL@Retail_Sales_ETL to move Sales fact to stage tables.

l

A workflow stream RetailPOSETL@Product_ETL to move Product dimension to stage tables.

l

A workflow stream RetailPOSETL@Store_ETL to move Store dimension to stage tables.
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l

A workflow stream RetailPOSETL@Promotion_ETL to move Promotion dimension to stage
tables.

As shown in the following figure, successful completion of the streams is indicated using green
color.

View Reports
Now that you installed the Domain and Reports component packages and the data is loaded into
the data warehouse, you can view the report on the SAP BusinessObjects InfoView interface. See
"Viewing Reports on SAP BusinessObjects InfoView" on page 38.
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Creating a Content Pack—Simplified
This section describes a simplified method of creating the Domain, ETL, and Report components of
a content pack with the following data sources:
l

Generic Database
SHR collects data from only those databases that support Java Database Connectivity (JDBC).

l

HP Operations agent or HP Performance Agent

l

CSV files

Analyze the Data Source
You must identify the data source containing metrics that are suitable to be fed into the Domain
data model. To design the data model, see section ""Design the Data Model " on page 17".

Generic Database as Data Source
When the SHR data source is a generic database (Microsoft SQL, Oracle, Sybase IQ and so on),
perform the following steps to generate the Domain, ETL, and Report components of the content
pack:
1. Using the command prompt, change to the %CDE_HOME%\bin directory.
2. Run the following command:
createcpfolders.bat -package RetailPOS -type all
The folders for the content pack components (Domain, ETL, and Report) are created.
3. Create the following input files based on the attached samples for RetailPOS and save them in
the %CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source folder:
Note: To read the contents of the sample attachments in this PDF document, click the
Attachments: View File Attachments icon and double click to open the XML file in your
browser window.
a. Database Connection Properties File (dbconfig.properties)
This file contains log in credential details of the data source (generic database) from which
content pack fetches data. It also contains the SHR database credentials that you will
require for generating the SAP BusinessObjects Universe.
b. Database Query XML File (RetailPOS_Query.xml)
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This file contains the SQL queries to fetch data from the data source (generic database). It
also contains the table and column definitions in SHR to store the data.
SHR bundles JDBC drivers for Microsoft SQL, Oracle, PostgreSQL, and Sybase IQ
databases in the CDE.zip file. If you have a different database, you must copy the relevant
JDBC driver to the SHR system and the content development environment.
4. With the Database Connection Properties File and the Database Query XML File as input, run
the following command to generate the mapping (ModelMapper.CSV) file:
createMappingFile.bat -useDB -passwords "mssql.password=<password>" dbQueryXml %CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\RetailPOS_
Query.xml -config %CDE_HOME%\samples\RetailPOS_Demo_Content_
Pack\Source\dbconfig.properties
Verify the values in the mapping CSV file and, if required, modify it manually based on your
business requirement.
5. Run the following command to generate the content pack:
createendtoendcp.bat -mappingfile "%CDE_HOME%\workspace\RetailPOS\RetailPOS_
MappingFile2394283040045872.csv" -collectionpolicyxml "%CDE_
HOME%\workspace\RetailPOS\RetailPOS_CollectionPolicy.xml" -configfile "%CDE_
HOME%\samples\RetailPOS_Demo_Content_Pack\Source\dbconfig.properties" password "db.password=<password>"
The Domain, ETL, and Report components of the content pack are now created.

CSV Files as Data Source
When the SHR data source is a CSV file, perform the following steps to generate the Domain, ETL,
and Report components of the content pack:
1. Using the command prompt, change to the %CDE_HOME%\bin directory.
2. Run the following command:
createcpfolders.bat -package RetailPOS -type all
The folders for the content pack components (Domain, ETL, and Report) are created.
3. Create the following input files based on the attached samples for RetailPOS and save them in
the %CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source folder:
Note: To read the contents of the sample attachments in this PDF document, click the
Attachments: View File Attachments icon and double click to open the XML file in your
browser window.
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a. CSV Connection Properties File (dbconfig.properties)
This file contains log in credential details of the data source (generic database) from which
content pack fetches data. It also contains the SHR database credentials that you will
require for generating the SAP BusinessObjects Universe.
b. CSV Policy File (RetailPOS_Query.xml)
This file contains the SQL queries to fetch data from the data source (generic database). It
also contains the table and column definitions in SHR to store the data.
4. With the CSV File and the CSV Policy XML File as input, run the following command to
generate the mapping (ModelMapper.CSV) file:
createMappingFile.bat -useCSV -csvXml %CDE_HOME%\samples\RetailPOS_Demo_
Content_Pack\Source\RetailPOS_Query.xml -config %CDE_HOME%\samples\RetailPOS_
Demo_Content_Pack\Source\dbconfig.properties -inputLocation %CDE_
HOME%\inputcsvs-outputLocation %CDE_HOME%\workspace\RetailPOS
Verify the values in the mapping CSV file and, if required, modify it manually based on your
business requirement.
5. Run the following command to generate the content pack:
createendtoendcp.bat -mappingfile "%CDE_HOME%\workspace\RetailPOS\RetailPOS_
MappingFile2394283040045872.csv" -configfile "%CDE_HOME%\samples\RetailPOS_
Demo_Content_Pack\Source\dbconfig.properties" -password
"mssql.password=<password>"
The Domain, ETL, and Report components of the content pack are now created.

HP Performance Agent as Data Source
When the SHR data source is HP Performance Agent, perform the following steps to generate the
Domain, ETL, and Report components of the content pack:
1. Using the command prompt, change to the %CDE_HOME%/bin directory.
2. Run the following command:
createcpfolders.bat -package RetailPOS -type all
The folders for the content pack components (Domain, ETL, and Report) are created.
3. Create the following input files based on the attached samples for RetailPOS and save them in
the %CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source folder:
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Note: To read the contents of the sample attachments in this PDF document, click the
Attachments: View File Attachments icon and double click to open the XML file in your
browser window.
a. Connection Properties File (dbconfig.properties)
This file contains information on the RTSM host name, port, user name, and the HP
Performance Agent host name from which the content needs to be developed. It also
contains the SHR database credentials that you will require for generating the SAP
BusinessObjects Universe.
b. Topology Policy XML File (TopologyRTSM_OM.XML)
This file contains the view names, CI types and the attributes to be collected or excluded
from CI types. It also contains the HPOM class names and data source details. In case of
HPOM collection policy, the attribute names are generated for OOB content. For new CI
types, the attributes must match with the attributes specified in the CMDB collection
policy.
c. HP Performance Agent Policy XML File (Fact_PA.XML)
This file contains the HP Performance Agent data source and classes from which data
needs to be collected.
4. With the earlier files as input, run the following command to generate the mapping
(ModelMapper.CSV) file:
createMappingFile.bat -usePA -paXml %CDE_HOME%\samples\RetailPOS_Demo_
Content_Pack\Source\Fact_PA.xml -topologyXml %CDE_HOME%\samples\RetailPOS_
Demo_Content_Pack\Source\TopologyRTSM_OM.xml-config %CDE_
HOME%\samples\RetailPOS_Demo_Content_Pack\Source\dbconfig.propertiesoutputLocation %CDE_HOME%\workspace\RetailPOS -passwords <RTSM password>
Verify the values in the mapping CSV file and, if required, modify it manually based on your
business requirement.
5. Run the following command to generate the content pack:
createendtoendcp.bat -mappingfile "%CDE_HOME%\workspace\RetailPOS\RetailPOS_
MappingFile2394283040045872.csv" -topologyxml %CDE_HOME%\samples\RetailPOS_
Demo_Content_Pack\Source\TopologyRTSM_OM.xml -paXml %CDE_
HOME%\samples\RetailPOS_Demo_Content_Pack\Source\Fact_PA.xml -configfile
%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\Source\dbconfig.properties
The Domain, ETL, and Report components of the content pack are now created.
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Generating Domain and ETL Component Package
1. Browse to %CDE_HOME%\workspace\RetailPOS\RetailPOSDomainCP.ap\dist (for
Domain) and %CDE_HOME%\workspace\RetailPOS\RetailPOSETLCP.ap\dist (for ETL)
2. Copy RetailPOS Domain and ETL to %PMDB_HOME%\packages.
Copying the package makes it available in the Deployment Manager for installation.
Note: It is not necessary to have SHR installed on the machine where you are creating the
Domain component package. If you created the Domain component package on another
machine, you must copy the package to the SHR machine under %PMDB_
HOME%\packages.

Install the Domain and ETL Component Package
SHR provides the Deployment Manager utility on the Administration Console to install the content
pack component packages. For instructions on how to install the content pack components, see
the HP Service Health Reporter Installation and Configuration Guide.

Viewing SHR Reports
To view the reports based on the data you collected using the content pack you created, perform
the steps in the following sections according to the order mentioned :
1. "Export the Universe to SAP BusinessObjects Repository" on page 27
2. "Create Web Intelligence Reports" on page 29
3. "Exporting Reports to SHR" on page 31
4. "Viewing Reports on SAP BusinessObjects InfoView" on page 38
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Creating a Data Source for ETL Component
To create a sample PostgreSQL database, SHR provides the following files and scripts:
Files / Scripts Provided by SHR

Location of File / Script

The following .csv files that are
copied into the database tables by
using scripts:

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\R
etailPOS_DB_Creation_Scripts\RetailPOS_CSV

RetailPOS_Product.csv
RetailPOS_Promotion.csv
RetailPOS_Sales.csv
RetailPOS_Store.csv
RetailPOS_CreateDatabase.sql

This SQL script creates a
PostgreSQL database named
RetailPOS for the user named
retail_admin.
RetailPOS_CreateTables.sql

This SQL script creates tables in
the RetailPOS database.
RetailPOS_PopulateTables.sql

This SQL script copies the .csv
files from the location %CDE_
HOME%\samples\RetailPOS_
Demo_Content_Pack\RetailPOS_
DB_Creation_
Scripts\RetailPOS_CSVto the
database tables.

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\R
etailPOS_DB_Creation_Scripts

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\R
etailPOS_DB_Creation_Scripts

%CDE_HOME%\samples\RetailPOS_Demo_Content_Pack\R
etailPOS_DB_Creation_Scripts

Prerequisites: Perform the following tasks before you start creating the PostgreSQL database:
Download and install PostgreSQL software from http://www.postgresql.org/. You can install
PostgreSQL on any system which can be different than the system on which SHR is installed.
Copy the following files to the C:\ drive of the system where you installed PostgreSQL.
l

l

RetailPOS_CSV
RetailPOS_CreateDatabase.sql
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l

RetailPOS_CreateTables.sql

l

RetailPOS_PopulateTables.sql

Create a PostgreSQL Database
To create the database named RetailPOS, follow these steps:
1. Logon to the system where you installed PostgreSQl as Administrator.
2. Start the PostgreSQL pgAdmin III program.
3. Connect to default user postgre with the password you configured.

The Object browser pane shows the databases available for the postgre user.
4. On the SQL Query Editor window click File ->Open. Browse to the location on C:\ drive where
you copied the script RetailPOS_CreateDatabase.sql and click Open.
5. Click Execute pgScript to run the RetailPOS_CreateDatabase.sql script.
The script creates the retailpos database and retail_admin user as the database owner.
6. Close the SQL Query Editor and click Refresh.
The retailpos database with user retail_admin appear on the Object browser window.

Create Database Tables
To create tables within the retailpos database, follow these steps:
1. On the Object browser window, select retailpos from the list of databases and open the SQL
Query Editor.
2. On the SQL Query Editor window click File ->Open. Browse to the location on C:\ drive where
you copied the script RetailPOS_CreateTables.sql and click Open.
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3. Click Execute pgScript to run the RetailsPOS_CreateTables.sql script.
The following tables are created as shown in the following figure:
n

retailpos.product

n

retailpos.store

n

retailpos.promotion

n

retailpos.sales

Insert Data into the Database
To insert data from the .csv files into the tables, follow these steps:
1. On the SQL Query Editor window click File ->Open. Browse to the location on C:\ drive where
you copied the script RetailPOS_PopulateTables.sql and click Open.
2. Click Execute pgScript to run the RetailPOS_PopulateTables.sqlscript.
The script inserts the .csv files from RetailPOS_CSV to the database tables.
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collection of data from the specified data
source

Glossary
L
C

Loading

CDE

The process of loading data from the
stage tables to the data warehouse
tables.

CDE is a set of tools provided by SHR for
development of content packs.
Collection policy
A Collection policy is written in XML to
define the metrics to be collected by a
collector program from the specified data
source.

R
Reconciliation
Data reconciliation is the technique of
associating fact data to corresponding
dimension data.

Content pack
Content packs are data marts deployed
on the SHR performance management
databaseplatform. Content packs enable
the platform to collect, store, process,
and report the data. Acontent pack has
three components – Domain, ETL, and
Reports.

Reports Component
The Reports component contains the
SAP BusinessObjects Web Intelligence
reports and universes.
S
Staging

D

Data staging is the process of moving the
collected, transformed, and reconciled
data into the staging tables.

Data Model
Data model is a schema diagram that
illustrates the relationship between
dimension tables (that have attributes)
and fact tables (that have measures).

T
Transformation

Domain Component
Domain component of a content pack
defines the data model of the Domain you
are reporting on along with the logic to
perform processing on the data. It is
independent of the data source you
collect data from.
E
ETL Component

Data transformation is the optional step
of cleaning the collected data according
to business requirements.
W
Workflow Streams
Workflow streams in content packs are
used to define and control the movement
of data from one step to another.

ETL component of a content pack is data
source dependant; it defines the
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We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:
Feedback on Service Health Reporter, 9.31 Content Development - Getting Started Guide
Just add your feedback to the email and click send.
If no email client is available, copy the information above to a new message in a web mail client,
and send your feedback to docfeedback@hp.com.
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